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Z100™ Electrochemical Impedance Analyzer  

Electrochemical Impedance Spectroscopy (EIS) has emerged as a powerful technique for defining 

reaction mechanisms and physical structures involved in a wide variety of electrochemical applications 

including 

• Biological systems 

• Surface structures 

• Corrosion processes 

• Battery and fuel cell  

The EDAQ Z100™ EIS System provides the means to turn an existing potentiostat/galvanostat into a fully 

functioning EIS System with full analysis and modeling capability. 

The single channel Z100 is based on the experience gained from the development of a 6 channel EIS 

system and includes many useful enhancements. 

The complete system is software controlled and all functions such as ranging, calibration, and 

measurements can be automated. 

This manual describes the Z100 Navigator software application which controls and sets up the operating 

parameters of the Z100 system.  Standard Features for the Z100 include the following: 

• Specially Designed for AC Impedance Experiments 

• Versatile Waveform Generator/Analyzer 

• Frequency Range of 1 µHz to 100 kHz 

• Data Presentation, Analysis and Modeling with ZMAN software 

• 1 Output for the Excitation voltage 

• 2 Analog Inputs: 1 for Current and 1 for Voltage Response Auto ranging 

• High Speed USB Interface 

With the help of Z100 Navigator software, the Z100 and EDAQ EA163 potentiostat provide the means 

to perform a number of common electrochemical impedance spectroscopy (EIS) experiments. 

The available techniques and Setup Parameters are described in the sections that follow and are detailed 

below — Available techniques. 
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Available Techniques 

The basic function of the Z100 is to generate predefined periodic excitation waveforms, apply them to a 

system under test and to measure the resulting current and voltage magnitude and phase responses 

simultaneously. The Z100 system is normally supplied with an EA163 POTENTIOSTAT connected via I2C 

bus to the Z100. This configuration supports PEIS, GEIS & GHFR. 

3rd party potentiostats/galvanostats and Electronic Loads are also supported – contact EDAQ for details.  

With waveforms and analysis methods provided, the following EIS techniques are available with Z100 

Navigator software.  

List of Techniques 

With an EA163 POTENTIOSTAT or 3rd party potentiostat/galvanostat 

• Potentiostatic Electrochemical Impedance Spectroscopy (PEIS)  

• Galvanostatic Electrochemical Impedance Spectroscopy (GEIS) 

• Galvanostatic High Frequency Resistometry (GHFR) 

Other techniques can be implemented with the Z100 – contact eDAQ to discuss your 

application. 

Potentiostatic Electrochemical Impedance Spectroscopy (PEIS) 

The Z100 can measure a full impedance spectrum over a selected frequency range using the EA163 

POTENTIOSTAT in potentiostatic mode.   The sample under test is driven by a small AC potential 

superimposed on a DC (Bias) Potential (Figure 1).  The resulting AC current magnitude and phase is 

measured.  This is repeated for every selected frequency to build up the impedance spectrum. 

 The parameters that are accessible to control the experiment are detailed below. 

 

Figure 1 PEIS Applied Waveform 

Potentiostatic EIS Setup Parameters 

Parameters listed below and displayed in Figure 2 can be changed or alternatives selected by double 

clicking on the item. 

Conditioning: FALSE (not selected) double click to select TRUE. This provides the means to apply a 
constant conditioning potential before the experiment is run. 

Time:  Duration of conditioning phase. 
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Potential vs Eref:  DC potential applied during conditioning phase. Eref is normally a WE at 0 
Volts. 

Initial Delay:  FALSE (not selected) double click to select TRUE 

Time:  The cell is turned off for specified time before the experiment is run. 

Stability:  The potential of the cell (Eoc) is measured and the system waits until a required 
stability value in mV/sec is reached. If no Initial delay is specified, Eoc is set to 0 vs Eref. 

DC Voltage:  DC voltage applied to sample during the experiment. The DC voltage can either be 
specified with respect to Eoc or Eref.  For example 2V with respect to Eref is equivalent to 0.5V with 
respect to Eoc if Eoc =1.5V. This type of setting is applicable when testing batteries. 
 

 

Figure 2 Potentiostatic EIS setup window 

 

 

AC Amplitude: Amplitude of sinusoidal excitation superimposed on DC Potential. Default 100mV. 

Initial Frequency [Hz]:  The starting frequency.  See Note on Frequency selection below. 

Mid Frequency [Hz]:  The frequency at which the frequency steps alter their direction. If Mid frequency 
has the same value as Initial Frequency then the frequency change only occurs in one direction.   

Final Frequency [Hz]:  The final frequency reached during a scan. 

Repeats: Sets the number of frequency sweeps performed. Default is 1. 

Density [points/decade]: Sets the number of points in a frequency sweep decade. Typical value is 
10/decade. It can range from 1 to 5000. Default is 5 points/frequency decade. 

Speed: Defines how many complete sine waves are used in the measurement. The number of cycles can 
be set in the “Tools - Option” dialog (see Fig 14). An extra cycle is added at the beginning to allow 
transients to settle. It is not used in the analysis. At high speeds a larger number of cycles can be 
measured to reduce the effect of noise. 
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Cell:  selects one of 3 conditions: 

Standby: in this state the potentiostat will be disconnected from the external cell.   When an 
experiment is performed the Real (external) cell will be automatically connected to the 
potentiostat, the experiment completed and the external cell then automatically disconnected. 

Dummy:  The potentiostat is connected to the internal 100 kohm dummy cell. 

Real Cell: in this state the real cell is connected to the potentiostat and remains connected 
before, diring and after an experiment. 

Current Range [mA]: Sets the required POTENTIOSTAT current range. Typically start at 10mA range. If 

an EA163 potentiostat is connected, the measurement starts at the given current range. If “Autorange” 

is set, current range is automatically changed for better resolution based on the measured impedance. 

(This feature will be added as a software update) 

Phase correction:  By storing the phase response from a pure resistance the phase shift due to 
instrumentation can be partly compensated. True ON, False Off 

Galvanostatic Electrochemical Impedance Spectroscopy (GEIS) 

The Z100 will measure a full impedance spectrum using the EA163 POTENTIOSTAT in galvanostatic 

mode.  The sample under test is driven by a small AC current superimposed on a DC (Bias) Current 

(Figure 3).  The resulting AC voltage magnitude and phase is measured.  This is repeated for every 

selected frequency to build up the impedance spectrum. 

The parameters that are accessible to control the experiment are detailed below. 

 

 

Figure 3  GEIS applied waveform 

Galvanostatic EIS and Setup Parameters 

A List of Setup Parameters similar to those described above is available to setup conditions for a GEIS 

experiment. 

List of Setup Parameters. 

Conditioning: see above 

Initial Delay: see above 

DC Current [mA] +AC Amplitude [mA]: Small sinusoidal perturebation signal with amplitude of AC 
Amplitude is superimposed on DC Current. 

Frequency settings: see above: To set how many measurements will take 

Repeats: see above To set interval between two successive measurements. 

Current Range [mA]: To set desired current range of EA163 POTENTIOSTAT 
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Pseudo-Galvanic: If enabled, the AC amplitude is not fixed. The value may be changed based on “Max 
Vac / Impedance”. This is introduced to make sure the Linearity condition in electrochemical cell. 
Commonly when AC voltage is below 50mV, the linearity condition (V/I) is valid. If the initial value 
chosen for Vac is too high then this mode may not work correctly. 

 

 

Speed: see above 

Cell:  see above 

Phase correction: see above. 

Galvanostatic HFR (GHFR) 

Z100 will measure time-evolved impedance data at fixed frequencies, see Figure 4, using the EA163 

POTENTIOSTAT operating in the galvanostat mode.  
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Figure 4 GHFR Applied waveforms 

Galvanostatic HFR and Setup Parameters 

Parameters listed below can be changed or alternatives selected by double clicking on the item. 

 

Frequency [Hz]: To set a single frequency 

Speed: Only fast speed is available 

Interval: time between frequency bursts 

Duration: sets total duration of cycle 

 

Cyclic Voltammetry 

 The parameter table for Cyclic voltametry is shown below 
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Note on Frequency selection: 

Frequency will be scanned from “initial” to “mid” and stop on “final”. The scan has no preferred 

direction – the system can scan from high to low or low to high. The typical and preferred direction of 

frequency scanning is from high to low.  Scanning at high frequencies is faster and inappropriate 

settings can be more quickly identified.  Scanning at low frequencies, for example at 1mHz, takes 1000 

seconds to complete one frequency so it’s a long time to wait to detect an error. 

To scan from one frequency value to another two of the values can be the same as shown below: 

Initial Frequency: 1Hz 

Middle Frequency: 20Hz 

Final Frequency: 20 kHz 

These settings will scan form 1Hz to 20 kHz 

 

Initial Frequency: 10 kHz 

Middle Frequency: 1 Hz 

Final Frequency: 10k Hz 

These settings will scan from 10 kHz to 1Hz and back to 10 kHz. 

Initial Frequency: 1 kHz 

Middle Frequency: 1 kHz 
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Final Frequency: 1 kHz 

Repeats = 100 

These settings will repeat a single frequency (1 kHz) 100 times. 

Notes on Potententiostats/Galvanostats 

The Z100 system is designed to operate at its rated 100 kHz Bandwidth with minimum internal phase 

shift.  External Potentiostats/Galvanostats,their internal settings, input cables and the External Cell being 

tested will all affect the Magnitude and Phase response and the stability of the system. 

The EA163 potentiostat operates with a <10 degree phase @100 kHz bandwidth at 100mA, 10mA and 

1mA ranges, 100uA @15kHz and 1uA and below at 1.5 kHz. Measurement of high impedances requires 

operations at lower bandwidths. In Galvanostat Modes similar performance is attainable but in this case 

the possibility of instability (parasitic oscillations) is more likely due to the external cell and in such case 

High Stability option is available that restricts operation to 1.6 kHz. 
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Software Installation 

Insert your software CD in the CD tray. 

Run Setup.exe and follow on screen prompts.  Once installation is complete both Z100 Navigator and 

ZMAN applications should be available in your Program folder and short-cut icons should appear on your 

desk top.   Click on the Z100 Navigator icon to initiate the program. On start up the Z100 Navigator 

window will be displayed and will indicate that the Z100 and the attached potentiostat have been 

detected (see below). 

 

 

 

On completion of its start up process – which can take up to a minute- the following Start up screen will 

be displayed (Figure 5) to indicate that the system is ready for operation. The system is now ready for 

use. 

 

Figure 5 Z100 Start up screen. 
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Hardware Installation 

Connect the hardware as shown below: 

System Requirements: 

P4 or above CPU, Memory >512M,  

Support USB port, suitable for WIN XP, Vista 32 or Windows 7 OS. 

Front Panel Indicators 

 

Figure 6 Front Panel of Z100 

Power: Power ON indicator 

Active: ON when ready to run a measurement. 

Busy:  It’s blinking when Z100 was running. 

Trigger:  On when triggered  

Rear Panel Description 

 

Figure 7 Rear Panel of Z100 

Ein:  Voltage signal input from Potentiostat 

Iin:  Current signal input from Potentiostat 

Sig Out:  Excitation signal from Z100 to potentiostat 

I2C Bus:  Communications cable to Potentiostat 

USB:  Communications cable to Computer USB port 

Power:  Mains input 
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Typical System Interconnections/ External Cabling to EA163 POTENTIOSTAT 

Refer to factory for connection to other 

potentiostat

 

 

When your hardware has been connected as shown in Figure 7, apply power – all indicator lights should 

come on momentarily and then go off except for the Green Power LED and the Active LED. The 

potentiostat should Indicate that it is OFF Line (green LED off) and the Overload Light is OFF to indicate 

that there is no overload condition present. 

Note: the Potentiostat Overload LED will be ON when the system is first switched on in order to confirm 

that the Overload circuit is operational. The Overload light may remain ON until the Potentiostat is 

accessed by the software for the first time at which point it the Overload light will be reset. 

System 

under Test 

CE 

RE 

WE 

CPU 

Figure 8 Z100 cabling to EA163 POTENTIOSTAT 
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System Configuration 

A start up window Figure 9 will be displayed when the application is launched. It consists of a number of 

menus described below to allow system configuration, experiment setup as well as monitoring and data 

recording during experiments. 

 

Figure 9 Start up screen detail 

File: 

This menu item provides the means to open a file, save a file and open recently used files. See Saving 

Data section for more detail on data files naming and structure. 

Device: 

This menu item ( Figure 10) provides facilities for detecting initializing and resetting Active Z100 devices 

and external Potentiostats. Some of these commands relate to circumstances in which multiple Z100 are 

connected to the system.  In most cases the Z100 system connected to your PC will be automatically 

found, reset and installed and there is no need to initiate any of these commands. 

 

Figure 10 Device Menu 

 

Loopback:  is an important setting that can be used in order to test the operational integrity of 

the Z100 system. By selecting this item a self test of the Z100 can be performed – see Z100 

Quick Start Manual for details of this procedure. 

Initialize External P/G: this can be used to reset and initialize the external potentiostat.  

Typically this command is performed automatically during startup so there will not be a need to 

perform this command unless some condition occurs that prevents the potentiostat from 

operating correctly or from being recognized by the Z100 system. 
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Experiment: 

 This is used for selecting the experiment to be performed. Either PEIS, GEIS can be selected and when 

selected the appropriate setup command menu is displayed. In addition this menu also provides the 

means to generate waveforms to implement 3 common electrochemical techniques: 

Cyclic Voltammetry. 

Linear Sweep Voltametry 

Square Wave voltametry 

Operation: 

Start and Stop Function Keys – other function Key initiated operations can be included here. 

Tools:  

This menu (Figure ) provides an important set of commands described below 

Transient recorder: this provides an independent method of generating a number of waveforms that 

can be applied to a system under test. A full description is available at the end of this section. 

 

Figure 11 Tools Menu 

Update Firmware:  DO NOT invoke this command without specific instructions. This command 

provides means to upgrade the firmware. Firmware Updates can be performed when new firmware 

becomes available and instructions for this operation will be provided with the Firmware upgrade 

document. 

Calibrate device: This advanced command allows the system to perform a self calibration routine. The 

resulting calibration files can be saved and reloaded. The calibration routine takes approximately 45 

minutes to perform and should not be invoked unnecessarily. The system calibration will remain stable 

for a many weeks and typically should be executed if the system has remained unused for a long period. 

The date of last calibration is indicated. 

To invoke the calibration routine: 

Select  Enable Calibration 

Select  Analog Out Port and “Check All” 

Select Analog In Ports and “Check All” 

Do not select Other – this item allows internal delays to be measured and compensated as an 

alternative to Phase compensation. 
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Initialise will start the calibration process and when completed the calibration file can be saved. 

 

Figure 11a  Calibrate Device Menu 

 

Note On Calibrate device:   

Calibration data consists of three parts: 

Analog Out data calibrating the output waveforms 

Analog In Data calibrating the input data 

Other: this calibrates for minor delay differences in the signal paths and should not be used if  Analog 

Phase compensation is  used.   

Analog phase compensation records the Phase Shift for a null device – for example a fixed 5K resistor 

connected to the potentiostat and then uses this data to compensate for the phase error when Phase 

Compensation =TRUE in the Experiment parameter table.  

Calibrate External P/G:  this menu allows the external Potentiostat/Galvanostat to be calibrated.  One 

of the most important aspects of this section is the measurement of the Potentiostat “Blank” phase 

response so that this data can be used to correct for phase distortion introduced by the Potentiostat and 

the Z100.  See the Z100 Quick start manual for a description of the procedure to perform this task. 

File converter: Used for converting Z100 native files “Binary file” (*.wis, *.wiv) to “ASCII file” (*.z#, 
*.iv#).  See Figure 12. 

File extension convention: 
*.wis  >  AC Data  ( Voltage and Current data recorded during an EIS scan) > ASCII file  *.z# 
*.wiv  >  DC Data  (records DC data recorded during running of Electrochemical techniques such as 
Cyclic voltametry etc)  ASCII file  *.iv#.   This operation is not currently implemented in Z100 Navigator.  
DC data is saved when CV, LSV, and SWV techniques are enabled.  Currently this feature is not 
implemented in Z100 Navigator but is planned for future release. 

ZMAN 2.2 Analysis and Modeling application supplied with your system will only open Binary File that 
are generated on the Z100 system (*.wis  files).   If analysis of data recorded on other systems is required 
a standalone ZMAN 2.2 license may be purchased from EDAQ. 
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Converting your files to the ASCII format (*.z#) provides the means for this data to be read by other 
programs.  Z100 users may want to export their data to Excel or Origin software for publication. This file 
converter provides this facility. 

Folder for AC data” is stored internally for subsequent use. 

 

Figure 12 File converter menu 

Options Menu See Figure 13 and the following sub- menus 

General: some general set up commands defining start up scanning and conditions to be set at the 

conclusion of an experiment. 

File:  Allows control of and file management settings. 

• Automatically save data selected, Automatic file name and Data file format are 
enabled. See Fig 14 

• Automatically save data not enabled, data is not saved until you select File >Save As 
Binary Format… or Save as ASCII Format… in the File menu in the Main window. 

• Automatic file name enabled, EIS data is saved automatically in the Folder for AC data. 
File format can be binary or ASCII. 
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Figure 13 Options: File menu 

 

Figure 14 Options: EIS Menu 

Options Menu: 

EIS:   See Figure 14 

• Apply digital notch filter: controls whether to use the internal digital notch filter. Select 

appropriate mains frequency in your area. 

• Apply drift correction before analysis: During recording of an impedance spectrum, a 
potential drift can occur. The magnitude of drift is time dependent and can be compensated by 
software during the measurement 

• The formula is E_ measured(t) = E_ true(t) + a*t + b and we can get E true(t) by linear 
regression. 

• Fast gain control: If selected, PGA gain of each channel is calculated from the measured 
impedance and set automatically to the most appropriate value. If not selected, 

• If not selected, PGA gain is set by an iterative step-by step procedure: if the signal is too big, a 
lower gain is chosen and if the signal is too small, a higher one is selected. It is useful to 
measure very small impedances. In this case, measured impedance using inappropriate PGA 
gain may be significantly in error.  

• Use extended gains: The PGA amplifier has up to +40 dB of gain (x100). The analog filter can 
provide an additional X10 gain.  It is useful in measuring very low impedance (i.e. ~100uV 
amplitude of sine wave); however, calibration is not available at this extra gain. 
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External P/G Menu: these controls provide some control of external 3rd party Potentiostats.  Because 
the EA163 is recognized by the Z100 system and can communicate with the system directly, its control 
functions are available in the Z100 Navigator application. The Maximum allowable Bias voltage can be 
set here to prevent applying excessive Bias voltages to a system under test 

This setting applies to the Experiment settings- not the Transient recorder settings. 

Transient Recorder 

The transient recorder module contains a number of systems that allow control over the various 
elements of the Z100 system and a potentiostat attached to the system. In addition it provides an 
independent means to generate waveforms to test system performance. For example applying a square 
wave to the system can indicate if there are any transients which may indicate unstable conditions. 
Applying a signal at the frequency limits of the planned experiment can show if acceptable noise and 
distortion figures can be achieved. 

The notes below describe the various functions provided by this software module (see Figure 15). 

Hardware Appendix:  Please refer to this Appendix when reading this section, it will provide some 

useful information that will assist in understanding some of the hardware related features of this system. 

Important Note: Some of the settings in this menu may affect the same system parameter from two 

locations: from within the Transient Recorder menu or from the Experiment Set up menu. Each location 

can control its own settings.  For example the Bias voltage available intransient recorder mode is +/-

10Volts  whereas when doing experiments the Max Bias voltage can be set to an arbitrary value as 

described in External P/G see above. 

 

Figure 15 Transient Recorder screen 
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Analog Out: This section provides control over the Analog output excitation provided by the system 
and appearing on the Sig Out terminal of the Z100.  The following parameters are accessible: 

Bias Voltage: A DC bias or DC potential can be applied to the sample under test. Maximum allowed 
voltage is +/-10 Volts therefore the combination of DC bias and AC amplitude must not exceed 10Volts. 

Filter: a user selectable filter may be applied to the output waveform. 

Waveform:  Various waveforms including Sine, ramp and square can be selected and in addition 

arbitrary waveforms defined by an analytical function can be generated and output at amplitudes, 

frequencies and Initial phase specified in the menu.  Waveforms can be output continuously or in 

Burst mode and when this is enabled the number of cycles in a burst mode can be specified. 

Transient Record:  This displays both the current and voltage appearing at I in and Ein terminals of the 

Z100.  Axis Scaling will be automatic and any distortion will be visible. 

AI Configuration 

This tag provides information on the conditions applying to the last experiment. The two columns refer 

to the current and voltage channel and provide further diagnostic information.  

 

Figure 16 Transient recorder >AI Configuration 

The above settings (see Figure 16) allow the user to control the gains of the Current and voltage 

amplifiers as well as any applied bias, if there is distortion visible – reduce the gain and if there is too 

much noise then increase the gain. 

External P/G 

This menu provides the means to set the operating parameters of the external 

Potententiostat/Galvanostat.  The Mode, Current Range and Filter setting, High Stab mode used in 

Galvanostatic operations and the Cell arrangement can be configured.  
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Figure 17 Transient Recorder> External P/G 

Cell Configuration: 

Standby: in this mode the system is internally connected to the Dummy cell and the 

connections to the external cell are all “open” so that the system can have no effect on the 

external cell.  If this setting is chosen the system will switch to the Real Cell when the 

experiment begins and switches back to Standby mode at the completion of the experiment. 

Dummy Cell: this setting connects the potentiostat to the internal 100 kohm internal cell 

Real Cell: this setting connects the potentiostat to the External (Real) Cell. Any experiment will 

be performed on this cell and at the end of the experiment the cell will stay connected. 

Loopback:  Connects the Z100 output to its input in order to test the system with no external devices. 

See Quick Start manual. 

AC coupling:  See Hardware ADDENDUM.  This setting removes any DC offset. 

Apply Digital Filters: See Hardware ADDENDUM.  Applies post acquisition digital filters.   

X and Y axis:  These controls allow the display in real units (time and Current or voltage) or in actual 

ADC readings (number and value).  This can be used as a diagnostic test to show if the ADC converter is 

operating within its linear limits. 
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Monitoring and Data recording  

This section describes the monitoring and recording features of the software.  The contents and 

functions of the various buttons and menu items will be described below. 

 

 

Figure 18 Start up screen Detail 

 

At the bottom of the startup screen there are three items which will first be described. 

 

Figure 19 Start up summary line 

Galvanostatic EIS or Potentiostatic EIS: 

Accessing this item brings up a Command menu (see Fig 2) that allows either a PEIS or GEIS 

experimental conditions to be defined. The experiment that will be run when the Run button is activated 

is defined here. 

1/13 GEIS or PEIS: 

This item brings up the complete list of steps that will be undertaken in carrying out the next 

experiment. During data acquisition this item will indicate the step reached. 

 

Figure 20 List of Experiment Steps 
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File destination 

The destination of the experiment file will be automatically generated by the system and the location will 

be displayed in the RHS cell. 

Run/Stop Buttons and Activity Indicators 

These commands START and STOP an experiment and indicate progress as the experiment proceeds.   

 The Start command will begin the experiment and it can be terminated at any time by the Stop 

command –waiting until the experiment is completed will result in a complete data file stored in the 

location indicated at the bottom RHS of the display. 

Results 

Once an experiment is started and data obtained it will be displayed in the Results table. 

 

Figure 21  Results Table 

When an experiment is started the system displays an Analysis Status (see Figure 22) which will indicate 

the condition of the input signals.  As the system automatically adjusts for optimum settings it will 

indicated that at some settings the signals may be too noisy, too small or too large. Eventually it will 

indicate that All channels are OK and measurements can proceed and the above table of results 

displayed.  It is for this reason that it is advised that experiments start from High frequencies as these 

measurements can be done more quickly in case some problems prevent optimum conditions to be 

found. If appropriate conditions are not found the system will try a number of times and then stop.  

Connections to the system under test should be checked and possibly new experimental or equipment 

parameters should be selected. 

 

Figure 22 Analysis Status 

As the experiment proceeds results will be displayed as a table of real and imaginary impedance and 

admittance values as well as in various graphical forms accessible at any time during the experiment by 

selecting the other menus available in this screen: 

Monitoring: display voltage and current waveforms 

Lissajous: displays an x-y plot of current and voltage data highlighting phase shifts 

Nyquist: displays real vs imaginary impedance 
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Bode: displays amplitude and phase vs Frequency 

AI1:  Current vs Frequency, spectral and error data  

AI2: Voltage vs Frequency, spectral and error data  

These screens display various forms of the data and a number of common controls are available to assist 

in the evaluation of this data. These common graphical features are described below: 

 

Figure 23 Graphics control icon located in the top left hand corner of each screen: 

The first Icon rescales the data to fit in the display. 

The second icon opens and closes a Graph Palette at the bottom right hand corner that 

provides the means to magnify move and select sections of the display.  The third icon brings up a cursor 

that displays X and Y values of cursor position. The cursor is constrained to move to experimental data.  

Clicking with the right button within a graph area brings up a selection that allows various functions 

such as copy data or graph to clipboard and a subsequent click of the left Button in the same area will 

bring up various options with regards to graph type, graph color and line type. 

The Data display screens available are described below. 

Monitoring 

While acquiring experimental data, the Z100 Navigator monitor screen displays the incoming current 

and voltage waveforms.  Typically the PEIS applied voltage will be 100mV and its scale is displayed on 

the RHS and the Current scale is displayed don the LHS. 

 

Figure 24 Monitoring screen 
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Lissajous 

While acquiring experimental data, the Z100 Navigator Lissajous screen displays the relationship the 

Current and Voltage waveforms in terms of their phase relationship.  A Graphics pallet tool provides the 

zoom function and the ability to copy the data.  Additional pallets as described above provide the means 

to modify the display in terms of line color and type. 

 

Figure 25 Lissajous Figure 

Nyquist 

The Nyquist screen displays a plot of Real and Imaginary Impedance values as shown in the plot below 

By clicking in the graph top RHS corner the cursor pallet can be displayed and numerical data associated 

with each point will be displayed. 

 

Figure 26 Nyquist Plot Section 
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Bode Plot 

The plot of signal Magnitude and Phase is displayed in a Bode plot as shown below. 

 

Figure 27 Bode Plot 

With the cursor enabled,  a view of the data showing numerical values associated with each point, can 

be provided. 

 

Figure 28 Bode Plot, Cursor enabled 
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Current & Voltage Time and Frequency domain data 

The top graph displays the raw data, overload data (if exists) and the fitted data. The Z100 Navigator 

manipulate the raw data by drift correction, offset canceling, and sine-fitting process. The calculation of 

impedance is based on the fitted data. 

The power spectrum graph displays the frequency content of the signal; this is used to evaluate the 

signal to noise ratio and other error terms. Typical EIS data shows the level of harmonics and noise is 

below -60 dB (1/1000). You can also evaluate the quality of measurement by Signal in Noise and 

Distortion (SINAD) and Total Harmonic Distortion and Noise (%THD+N) in the right box. Higher SINAD 

and lower %THD+N, indicates better measurements. 

In most cases the dominant frequency will be the applied frequency and the other terms will be over 

1000 times smaller. In the example below the noise frequency terms are individually about 1,000,000 

times smaller.  As the operating frequency increases in value its noise and distortion component will 

increase until eventually the measured signal is lost in noise.  

 

 

Figure 29 Time and Frequency Domain plots 
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Saving Data 

In its default mode Z100 Navigator data is saved automatically in C:\Z# Data folder. 

Data storage structure 

The Z# Data folder is located in your master hard drive(C:\).  Its structure is shown below.  Folders are 

automatically generated for each type of experiments performed on different dates.  Data files are 

automatically generated based on time data. Z100 Navigator thereby manages your data to make it easy 

to find an experiment or group of experiments for analysis with ZMAN. 

 

 

Figure 30 Structure of the Z# Data folder 

Data Storage 

Data storage is controlled by Tools>Options> File menu. Default conditions are shown in the figure  

 

Figure 31 Tools>Options>File menu 

By selecting Automatically save data the data will be saved in the structure defined above. If this 

mode is disabled the user will need to perform this function manually. 

Folders for AC Data specifies the folder where Impedance data will be stored. 

Automatic file name will generate either Binary (*.wis) or ASCII (*.z#) format files with the name 

generated from the date and time:  Month/Day/ YEAR Hour:Min AM/PM as shown below. 
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Figure 32 Data file listing 

ASCII Data 

Data can also be saved directly from the File Menu.  This useful if it is required to move the experiment 

data to an alternative analysis or display program.  If ASCII format is selected and the file saved to the 

desktop the following icon will appear.   

  

The  *z# file can be viewed with the Windows NotePad and it appears in the tabular format below and 

includes both the experimental data information and all the numerical data captured by the experiment. 

 

Figure 33 ASCII data (not all numerical data is shown). 

The alternative method of converting Z100 Binary data is by using the Tools>File converter menu.  In 

this case only the numerical data is recorded. 
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Addendum  A:  Hardware configuration 

There is no need to understand the internal hardware and software details of this system in order to be 
able to use it and produce good results.  However some understanding of the internal structure could be 
helpful in guiding the user to better utilize the features of the system. This addendum provides this 
background information. 

 

The Z100 EIS generates sinusoidal waveforms (AO) at frequencies form mHz to 100 kHz.  These 
waveforms are applied to the potentiostat and the voltages and currents across the Cell under test is 
measured by the Potentiostat and returned to the Z100 for processing and display. 

The first element to be described is the Z100 AO channel (Sig Out).  This consists of two precision Digital 
to Analog Converters (DAC’s) one of which generates the Excitation signal and the other generates a DC 
voltage that is used to apply a Bias or Applied DC potential.  These two signals are added to produce a 
DC level with an excitation signal superimposed.  This signal is filtered (reconstruction filter) to remove 
DAC noise to produce a smooth output waveform. This arrangement is shown in the diagram below. 

The Voltage (AI 2) and Current (AI 1) signals are processed by the Z100 to generate the Impedance data.  
Note that these two channels are identical and in some circumstances may be reversed by the 
potentiostat when it is operating in Galvanostat mode. (e.g. GEIS). 

AO Excitation 

Z100 EIS Potentiostat 

AI 1    

AI 2   Voltage Z  Cell 

under test 

Basic Structure showing the generation of an A0 Excitation signal and the subsequent 

measurement of the AI 1 and AI 2 signals in order to compute the complex impedance 

Z = AI2/AI1 = Mag & Phase 

To PC 

Figure 34  Basic Hardware structure 
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These signals will contain two components: a small sinusoidal AC waveform superimposed on a DC 

value.  In order to measure the AC component accurately the DC component must first be removed 

before the AC waveform can be amplified.  

 

 

To achieve this purpose these identical channels contains the following elements described below. 

x 1.0  Input amplifier Buffers the input voltages to a level that the system can handle (<10volts max).  

+ 

Input 

X 1.0 

Bias removal DAC: AC coupling 

PGA Analog ADC +/-2Volts Notch Filter --- Digital Filter 

AI Channel Block Diagram 

PC 

+ 
Excitation DAC 

DC Potential 

DAC 

Reconstruction 

Filter 

Output 

Amplifier 

Sig 

AO  Channel Block diagram 

Figure 35  Analog Output Channel Block diagram 

Figure 36  Current & Voltage input channels 
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Bias DAC provides an adjustable Bias voltage to remove any DC component in the input channel up to 

+/-10Volts.  This enables the PGA to amplify the AC component of the signal.  This in effect is a form of 

AC coupling implemented using a DC technique. In some circumstances it may be necessary to add the 

DC component back into the scaled data.  To do this switch off the AC Coupling flag and the DC 

removal will still take place but the value of the DC bias will be added back into the experimental data.  

PGA Programmable Gain Amplifier can provide adjustable gain with an approximate range of gains 

from x0.01 to x400. 

Note:  high gains inevitably result in higher noise levels so ensure that the system operates at levels as 

high as allowed by experiment being carried out.  The output from the PGA must produce a signal in the 

range of +/-2.000 volts to suit the input range of the ADC. 

Analog Filter is a Low Pass filter which can be digitally selected from 10 kHz to 150 kHz in 10 kHz 

steps.  PGEIS and PGEIS experiments select this setting automatically to track the frequencies being 

measured. This filter also has an additional gain of x10 available when really low level signals need to be 

measured.  However adding gain is not without cost and signal to noise ratio is reduced. This additional 

gain can be controlled in the Tools>Option>EIS menu: enable filter gain but in most cases this extra 

gain is not used. 

ADC:  a precision Analog to Digital Converter which converts the analog data for subsequent digital 

processing. 

Notch Filter this filter is implemented as a digital filter in the Z100 Navigator application.  It is used to 

remove Mains frequency noise and this must be set in the Tools>Option>EIS menu: Apply digital 

notch frequency. 

Digital Filter this filter is also implemented as a high order digital filter in the Z100 Navigator 

application.  It is a very sharp cut-off frequency filter and when enabled is used automatically to track 

the filter setting of the analog filter and remove frequencies above the frequency required by the 

measurement. It can be enabled or disabled Tools>Option>EIS menu: Apply digital filter. 

 

 

 

 

 

 

 

 

 

 

 

 


